<table>
<thead>
<tr>
<th>1. Report No.</th>
<th>FHWA/TX-09/0-5475-2</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Government Accession No.</td>
<td></td>
</tr>
<tr>
<td>3. Recipient's Catalog No.</td>
<td></td>
</tr>
<tr>
<td>4. Title and Subtitle</td>
<td>UTILITY ACCOMMODATION AND CONFLICT TRACKER (UACT) INSTALLATION AND CONFIGURATION MANUAL</td>
</tr>
<tr>
<td>5. Report Date</td>
<td>October 2008 Published: February 2009</td>
</tr>
<tr>
<td>6. Performing Organization Code</td>
<td></td>
</tr>
<tr>
<td>7. Author(s)</td>
<td>Edgar Kraus, Jerry Le, and Hussam Dawood</td>
</tr>
<tr>
<td>9. Performing Organization Name and Address</td>
<td>Texas Transportation Institute The Texas A&amp;M University System College Station, Texas 77843-3135</td>
</tr>
<tr>
<td>10. Work Unit No. (TRAIS)</td>
<td></td>
</tr>
<tr>
<td>11. Contract or Grant No.</td>
<td>Project 0-5475</td>
</tr>
<tr>
<td>12. Sponsoring Agency Name and Address</td>
<td>Texas Department of Transportation Research and Technology Implementation Office P.O. Box 5080 Austin, Texas 78763-5080</td>
</tr>
<tr>
<td>15. Supplementary Notes</td>
<td>Project performed in cooperation with the Texas Department of Transportation and the Federal Highway Administration. Project Title: Collection, Integration and Analysis of Utility Data in the Transportation Project Development Process URL: <a href="http://tti.tamu.edu/documents/0-5475-2.pdf">http://tti.tamu.edu/documents/0-5475-2.pdf</a></td>
</tr>
<tr>
<td>16. Abstract</td>
<td>Project 0-5475 performed a comprehensive analysis of utility conflict data/information flows between utility accommodation stakeholders in the Texas Department of Transportation project development process, developed data models to accommodate work and data flows between such stakeholders, developed a prototype system for the management of utility conflict data, and developed a tool for the visualization and analysis of utility conflicts within the prototype. This report provides a description of the required steps to install and configure the prototype system for the management of utility conflict data called Utility Accommodation and Conflict Tracker, or UACT. The report details the application’s architecture and system requirements, and provides guidance for the installation and configuration of all software components, including the Geographic Information System (GIS) mapping component and Oracle database. The report also details the activities required to populate the Oracle tablespaces after configuration is complete.</td>
</tr>
<tr>
<td>18. Distribution Statement</td>
<td>No restrictions. This document is available to the public through NTIS: National Technical Information Service Springfield, Virginia 22161 <a href="http://www.ntis.gov">http://www.ntis.gov</a></td>
</tr>
<tr>
<td>19. Security Classif.(of this report)</td>
<td>Unclassified</td>
</tr>
<tr>
<td>20. Security Classif.(of this page)</td>
<td>Unclassified</td>
</tr>
<tr>
<td>21. No. of Pages</td>
<td>128</td>
</tr>
<tr>
<td>22. Price</td>
<td></td>
</tr>
</tbody>
</table>
UTILITY ACCOMMODATION AND CONFLICT TRACKER (UACT)
INSTALLATION AND CONFIGURATION MANUAL

by

Edgar Kraus, P.E.
Assistant Research Engineer
Texas Transportation Institute

Jerry Le
Software Applications Developer
Texas Transportation Institute

and

Hussam Dawood
Student Worker
Texas Transportation Institute

Report 0-5475-2
Project 0-5475
Project Title: Collection, Integration, and Analysis of Utility Data in the Transportation Project Development Process

Performed in cooperation with the
Texas Department of Transportation
and the
Federal Highway Administration

October 2008
Published: February 2009

TEXAS TRANSPORTATION INSTITUTE
The Texas A&M University System
College Station, Texas 77843-3135
DISCLAIMER

The contents of this document reflect the views of the authors, who are responsible for the facts and the accuracy of the data presented herein. The contents do not necessarily reflect the official view or policies of the Federal Highway Administration (FHWA) or the Texas Department of Transportation (TxDOT). This document does not constitute a standard, specification, or regulation, nor is it intended for construction, bidding, or permit purposes. The engineer in charge of the project was Edgar Kraus, P.E. (Texas Registration #96727).

The United States Government and the State of Texas do not endorse products or manufacturers. Trade or manufacturers’ names appear herein solely because they are considered essential to the object of this report.
ACKNOWLEDGMENTS

This research was conducted in cooperation with TxDOT and FHWA. The researchers gratefully acknowledge the assistance provided by TxDOT officials, in particular the following:

- Randall “Randy” Anderson (Project Director)
- John Campbell, Right of Way Division (Program Coordinator)
- Jesse Cooper, Right of Way Division
- Karen Van Hooser, Technology Services Division
- Jim Kuhn, Technology Services Division
- Sylvia Medina, Research and Technology Implementation Office
- Gary Ray, Houston District
- Duncan Stewart, Research and Technology Implementation Office
- Tom Yarbrough, Research and Technology Implementation Office

The researchers also acknowledge the assistance provided by Cesar Quiroga and Nick Koncz of the Texas Transportation Institute in completing this manual.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>LIST OF FIGURES</td>
<td>ix</td>
</tr>
<tr>
<td>LIST OF TABLES</td>
<td>xiii</td>
</tr>
<tr>
<td>LIST OF ACRONYMS, ABBREVIATIONS, AND TERMS</td>
<td>xiv</td>
</tr>
<tr>
<td>CHAPTER 1. INTRODUCTION</td>
<td>1</td>
</tr>
<tr>
<td>SYSTEM OVERVIEW</td>
<td>1</td>
</tr>
<tr>
<td>CHAPTER 2. UACT SYSTEM REQUIREMENTS</td>
<td>3</td>
</tr>
<tr>
<td>SYSTEM ARCHITECTURE</td>
<td>3</td>
</tr>
<tr>
<td>SPACE REQUIREMENTS</td>
<td>5</td>
</tr>
<tr>
<td>Client Side Space Requirements</td>
<td>5</td>
</tr>
<tr>
<td>Server Side Space Requirements</td>
<td>5</td>
</tr>
<tr>
<td>Secondary Storage Requirements</td>
<td>6</td>
</tr>
<tr>
<td>MAPPING COMPONENT REQUIREMENTS</td>
<td>7</td>
</tr>
<tr>
<td>RETENTION REQUIREMENTS</td>
<td>8</td>
</tr>
<tr>
<td>CHAPTER 3. COMPLETE SOFTWARE COMPONENT INSTALLATION AND CONFIGURATION</td>
<td>11</td>
</tr>
<tr>
<td>INTRODUCTION</td>
<td>11</td>
</tr>
<tr>
<td>Names Used in UACT</td>
<td>12</td>
</tr>
<tr>
<td>FOLDER STRUCTURE AND DATA COPYING</td>
<td>12</td>
</tr>
<tr>
<td>MICROSOFT IIS INSTALLATION AND INITIAL CONFIGURATION</td>
<td>14</td>
</tr>
<tr>
<td>MICROSOFT OFFICE INSTALLATION</td>
<td>18</td>
</tr>
<tr>
<td>ORACLE CLIENT INSTALLATION</td>
<td>18</td>
</tr>
<tr>
<td>CIMMETRY AUTOVUE 2D DESKTOP INSTALLATION</td>
<td>27</td>
</tr>
<tr>
<td>MICROSOFT .NET 2.0 FRAMEWORK INSTALLATION</td>
<td>29</td>
</tr>
<tr>
<td>ADELIB EXPRESS SERVER INSTALLATION</td>
<td>30</td>
</tr>
<tr>
<td>ESRI ARCGIS SERVER V9.2 INSTALLATION</td>
<td>61</td>
</tr>
<tr>
<td>UACT MAPPING COMPONENT CONFIGURATION</td>
<td>62</td>
</tr>
<tr>
<td>Create A New ArcGIS Server Administrator</td>
<td>62</td>
</tr>
<tr>
<td>Create a New Map Service</td>
<td>65</td>
</tr>
<tr>
<td>Create A New Map Application</td>
<td>73</td>
</tr>
<tr>
<td>MICROSOFT IIS FINAL CONFIGURATION</td>
<td>82</td>
</tr>
</tbody>
</table>
LIST OF FIGURES

Figure 1. System Architecture ....................................................................................................... 3
Figure 2. UACT Folder Structure ................................................................................................. 13
Figure 3. IIS Manger Default Web Site ......................................................................................... 15
Figure 4. Virtual Directory Creation Wizard Virtual Directory Alias Window ......................... 16
Figure 5. Virtual Directory Creation Wizard Web Site Content Directory Window ................... 17
Figure 6. Virtual Directory Creation Wizard Access Permissions Window ............................... 18
Figure 7. Oracle Client File Locations Window ............................................................................ 19
Figure 8. Oracle Client Installation Types Window .................................................................... 20
Figure 9. Oracle Client Installation Summary Window ............................................................... 21
Figure 10. Oracle Client Configuration Tools Window ............................................................... 22
Figure 11. Oracle Net Configuration Assistant Welcome Window ............................................. 23
Figure 12. Oracle Net Configuration Assistant Database Version Selection Window ............... 23
Figure 13. Oracle Net Configuration Assistant Service Name Window ..................................... 24
Figure 14. Oracle Net Configuration Assistant Network Protocol Window ................................ 24
Figure 15. Oracle Net Configuration Assistant Host Name and Port Number Window ............. 25
Figure 16. Oracle Net Configuration Assistant Connection Test Window .................................. 26
Figure 17. Oracle Net Configuration Assistant Net Service Name Window .............................. 27
Figure 18. AutoVue Pen Settings Window .................................................................................. 28
Figure 19. AutoVue Customized Pen Settings Window ............................................................. 29
Figure 20. Express Server Window ............................................................................................ 31
Figure 21. Services Console Window Showing the Adlib Express Server Service .................... 32
Figure 22. Application Settings Window ..................................................................................... 33
Figure 23. Express Server Folder Options Window .................................................................... 34
Figure 24. Log Settings Window ............................................................................................... 35
Figure 25. Express Server Processing Settings Window ............................................................. 36
Figure 26. Express Server Outputs Settings Window ................................................................. 37
Figure 27. Convert to PDF Settings Window ............................................................................... 38
Figure 28. Convert to PDF Information Settings Window .......................................................... 39
Figure 29. Express Server PDF Options Settings Window ......................................................... 40
Figure 30. PDF Compression Options Window .......................................................................... 41
Figure 31. Bookmarks, Hyperlinks, and Table of Contents Settings Window ............................ 42
Figure 32. Font Embedding Options Window ............................................................................. 42
Figure 33. PDF Security Settings Window .................................................................................. 43
Figure 34. Transformation Settings Window ............................................................................... 44
Figure 35. PDF Open Settings Window ...................................................................................... 45
Figure 36. Express Server Document Options Window .............................................................. 45
Figure 37. Computer Aided Design Settings Window ................................................................ 46
Figure 38. HTML Settings Window ............................................................................................ 47
Figure 39. Text Settings Window ................................................................................................ 48
Figure 40. Express Server Main Interface Window ..................................................................... 49
Figure 41. Install Adlib Service Window .................................................................................... 50
Figure 42. Adlib Express Server Service Properties Window ..................................................... 51
Figure 43. Log On Tab of the Adlib Express Server Properties Window .................................... 52
Figure 44. Adlib FMR Properties Window.................................................................................. 53
Figure 45. DCOM Config Folder in the Component Services Window ....................................... 54
Figure 46. AdConv.AdConvNS Properties Window ................................................................... 55
Figure 47. Launch Permission Window ....................................................................................... 56
Figure 48. Access Permission Window ....................................................................................... 57
Figure 49. System Properties Window ........................................................................................ 58
Figure 50. Performance Options: Data Execution Prevention Setting Tab ................................. 59
Figure 51. Services Console ........................................................................................................ 60
Figure 52. General Tab of the Adlib Express Server Properties Window .................................... 61
Figure 53. GIS Administrators Properties Window ..................................................................... 63
Figure 54. Server Administrators Properties Window .................................................................. 64
Figure 55. ArcGIS Server Manager Login Page ......................................................................... 65
Figure 56. ArcGIS Server Manager, Services Tab .................................................................... 66
Figure 57. ArcGIS Server Manager, Add New Service, Step 1 .................................................. 67
Figure 58. ArcGIS Server Manager, Add New Service, Step 2 .................................................. 68
Figure 59. ArcGIS Server Manager, Add New Service, Step 3 .................................................. 69
Figure 60. ArcGIS Server Manager, Add New Service, Step 4 .................................................. 70
Figure 61. ArcGIS Server Manager, Add New Service, Step 5 .................................................. 71
Figure 62. ArcGIS Server Manager: Start New UACT Map Service......................................... 72
Figure 63. ArcGIS Server Manager, Applications Tab ............................................................... 73
Figure 64. ArcGIS Server Manager, Create New Web Application: Specify Name and Host ... 74
Figure 65. ArcGIS Server Manager, Create New Web Application: Select Map Service ....... 75
Figure 66. ArcGIS Server Manager, Create New Web Application: Select Tasks ................. 76
Figure 67. ArcGIS Server Manager, Create New Web Application: Configure General
Preferences of Task....................................................................................................................... 77
Figure 68. ArcGIS Server Manager, Create New Web Application: Configure Settings
Preferences of Task.................................................................................................................... 78
Figure 69. ArcGIS Server Manager, Create New Web Application: Verify Local Connection
User Name .................................................................................................................................... 79
Figure 70. ArcGIS Server Manager, Create New Web Application: Set Page Properties ........ 80
Figure 71. ArcGIS Server Manager, Create New Web Application: Overview Map Settings
Window....................................................................................................................................... 81
Figure 72. UACT Properties Window ......................................................................................... 82
Figure 73. UACT Properties Window: Virtual Directory Tab ..................................................... 83
Figure 74. Application Configuration Window: Options Tab ..................................................... 84
Figure 75. UACT Properties Window: HTTP Headers Tab......................................................... 85
Figure 76. MIME Types Window ................................................................................................. 86
Figure 77. New MIME Type Window.......................................................................................... 86
Figure 78. MIME Types Window: New MIME Type .................................................................... 87
Figure 79. IIS Manager Window: Web Service Extensions......................................................... 88
Figure 80. UACT-UserFiles Folder: Properties Window.......................................................... 89
Figure 81. UACT-UserFiles Folder: Security Tab ...................................................................... 90
Figure 82. ArcCatalog, Database Connections Window ............................................................ 91
Figure 83. Spatial Database Connection Window ........................................................................ 92
Figure 84. New Database Connection in Database Connection Window .................................... 93
Figure 85. Feature Class to Feature Class Window ..................................................................... 94
Figure 86. Feature Class to Feature Class Window, Output Feature Class ............................... 95
Figure 87. Feature Class to Feature Class Dialog Box ................................................................. 95
Figure 88. New Feature Class in Database Connection Window .................................................. 96
Figure 89. Oracle Enterprise Manager Screen: Administration Tab ........................................... 98
Figure 90. Oracle Create Tablespace Window ............................................................................ 99
Figure 91. Oracle Enterprise Manager: Add Datafile to Tablespace .................................. 100
Figure 92. Oracle Create Tablespace Window with New Tablespace ........................................ 101
Figure 93. Oracle Administration Window ............................................................................... 102
Figure 94. Oracle Create User Window ..................................................................................... 103
Figure 95. Oracle Modify Roles Window .................................................................................. 104
Figure 96. Command for Importing Dump File Uactdev_Owner ............................................. 106
Figure 97. Command for Importing Dump File Uactdev_User ............................................... 106
Figure 98. Command for Importing Dump File FileNet_User .................................................. 107
# LIST OF TABLES

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 1. UACT Tablespace Size Requirements</td>
<td>.........................................................</td>
<td>105</td>
</tr>
</tbody>
</table>
## LIST OF ACRONYMS, ABBREVIATIONS, AND TERMS

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ArcSDE</td>
<td>Arc Spatial Data Engine</td>
</tr>
<tr>
<td>ASP</td>
<td>Active Server Pages</td>
</tr>
<tr>
<td>CAD</td>
<td>Computer Aided Design</td>
</tr>
<tr>
<td>CCITT</td>
<td>International Telegraph and Telephone Consultative Committee</td>
</tr>
<tr>
<td>CSV</td>
<td>Comma Separated Values</td>
</tr>
<tr>
<td>DCIS</td>
<td>Design and Construction Information System</td>
</tr>
<tr>
<td>DCOM</td>
<td>Distributed Component Object Model</td>
</tr>
<tr>
<td>DEP</td>
<td>Data Execution Prevention</td>
</tr>
<tr>
<td>DOT</td>
<td>Department of Transportation</td>
</tr>
<tr>
<td>DPI</td>
<td>Document Processing Information</td>
</tr>
<tr>
<td>DVD</td>
<td>Digital Versatile Disk</td>
</tr>
<tr>
<td>ESRI</td>
<td>Environmental Systems Research Institute</td>
</tr>
<tr>
<td>FileNet</td>
<td>FileNet Electronic Document Management System</td>
</tr>
<tr>
<td>FHWA</td>
<td>Federal Highway Administration</td>
</tr>
<tr>
<td>FMR</td>
<td>Fault Monitoring and Recovery</td>
</tr>
<tr>
<td>GAIP</td>
<td>GIS Architecture Infrastructure Project</td>
</tr>
<tr>
<td>GIS</td>
<td>Geographic Information Systems</td>
</tr>
<tr>
<td>HPGL</td>
<td>Hewlett-Packard Graphics Language</td>
</tr>
<tr>
<td>HTML</td>
<td>HyperText Markup Language</td>
</tr>
<tr>
<td>HTTP</td>
<td>HyperText Transfer Protocol</td>
</tr>
<tr>
<td>IIS</td>
<td>Internet Information Services</td>
</tr>
<tr>
<td>IP</td>
<td>Internet Protocol</td>
</tr>
<tr>
<td>Acronym</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>ISO</td>
<td>International Organization for Standardization</td>
</tr>
<tr>
<td>MainStreet</td>
<td>MainStreet Texas Information System</td>
</tr>
<tr>
<td>MIME</td>
<td>Multipurpose Internet Mail Extensions</td>
</tr>
<tr>
<td>ODBC</td>
<td>Open Database Connectivity</td>
</tr>
<tr>
<td>PDF</td>
<td>Portable Document Format</td>
</tr>
<tr>
<td>ROW</td>
<td>Right of Way</td>
</tr>
<tr>
<td>ROWIS</td>
<td>Right of Way Information System</td>
</tr>
<tr>
<td>SP</td>
<td>Service Pack</td>
</tr>
<tr>
<td>TNRIS</td>
<td>Texas Natural Resource Information System</td>
</tr>
<tr>
<td>TSD</td>
<td>Technology Services Division at TxDOT</td>
</tr>
<tr>
<td>TTI</td>
<td>Texas Transportation Institute</td>
</tr>
<tr>
<td>TxDOT</td>
<td>Texas Department of Transportation</td>
</tr>
<tr>
<td>UACT</td>
<td>Utility Accommodation and Conflict Tracker</td>
</tr>
<tr>
<td>UFD</td>
<td>Utility Facility Database</td>
</tr>
<tr>
<td>UIR</td>
<td>Utility Installation Review</td>
</tr>
<tr>
<td>XML</td>
<td>Extensible Markup Language</td>
</tr>
</tbody>
</table>
CHAPTER 1. INTRODUCTION

SYSTEM OVERVIEW

The Utility Accommodation and Conflict Tracker (UACT) system is a web-based prototype for the management and tracking of utility conflicts. Key functionalities of UACT include:

- **Utility Conflict Tracking.** Department of Transportation (DOT) officials can enter utility conflict data based on existing utility facility data and create visual representations of utility conflicts using a mapping component. The prototype also provides an overview of the status of utility conflicts for each project.

- **Utility Agreement Development and Tracking.** A utility company can complete the required forms of a utility agreement online and file the document electronically for review by the appropriate district and division personnel. The system guides the user through the completion process and selects appropriate forms based on the specific circumstances of the utility conflict.

- **Document Upload and Conversion to portable document format (PDF).** The prototype allows users to upload documents that are accessible to other users based on roles and privileges. The prototype converts all documents automatically to PDF to allow easy access to all privileged users.

- **Design and Construction Information System (DCIS) Project Data Access.** The researchers designed the prototype to connect to DCIS and display project data that are collected in a DCIS data warehouse.

- **Utility Facility Database Access.** The researchers designed the prototype to integrate with a Geographic Information System (GIS) based database of utility facility features.

- **Sophisticated User Access Model.** UACT provides a sophisticated and flexible access system based on capabilities, roles, and privileges. UACT administrators can further customize access to UACT by providing individual users access to specific projects.

This manual describes the process to install and configure UACT. The document is divided into chapters as follows:

- **Chapter 1** is this introductory chapter.

- **Chapter 2** describes UACT system requirements.

- **Chapter 3** describes the steps to install and configure required and recommended UACT software components.
• Chapter 4 describes the steps to copy data to a tablespace in Oracle and verify UACT is working properly.

• Chapter 5 describes procedures to test and verify the correct installation of all UACT system components.
CHAPTER 2. UACT SYSTEM REQUIREMENTS

SYSTEM ARCHITECTURE

UACT is a system that consists of several components that researchers designed to manage utility conflict data using web-based access. As Figure 1 shows, UACT has two main groups of components: client-side components and server side components.

Figure 1. System Architecture.

On the client side, a web browser serves as a front-end interface that allows users on client computers to interact with the UACT system to complete the utility adjustment process. Both
utility company users and TxDOT users can act as clients, but their interfaces are different and have different access levels. To access UACT, users must have a computer that meets the following minimum system requirements:

- desktop or laptop computer running Windows® XP with Service Pack 2 (SP2),
- Microsoft® Internet Explorer® 6.0 with SP2 or higher,
- portable document format (PDF) reader such as Adobe® Acrobat Reader® 7.0,
- internet connection,
- email account, and
- UACT active account.

On the server side, UACT includes a number of system components, including the following:

- **Web server.** Microsoft Internet Information Services® (IIS) 6.0 running on Windows Server 2003®.
- **Spatial data engine.** ArcGIS Server can be configured to access spatial data in formats such as ESRI shape file format, personal geodatabases (.mdb file format), or geodatabases using ESRI’s Arc Spatial Data Engine® (ArcSDE®).
- **File upload component.** UACT currently uses a file upload component of ASP.NET™. UACT could use another upload component such as SoftArtisans® FileUp™.
- **PDF generator.** Adlib Software® Adlib Express Server® with Compressor Add-On. This standalone server application monitors the contents of a specific input folder at regular time intervals. In UACT, the application checks the contents of a designated input folder every five seconds. If Adlib Express Server detects a new file in that folder (typically if a utility company or TxDOT user has uploaded a file to the server), Adlib Express Server generates a PDF file and stores that file in a designated output folder. In order for Adlib Express Server to convert a file to PDF, an application that can open the file must be installed on the server.
- **Microsoft Office®** (Word®, Excel®, PowerPoint®, and Visio®). Adlib Express Server supports a number of native applications installed on the server, including Microsoft Office. In the current TTI implementation, UACT recognizes Word, Excel, PowerPoint, and Visio files, allowing Adlib Express Server to generate PDF versions of Word (.doc) files, Excel (.xls) files, PowerPoint (.ppt) files, and Visio (.vsd) files.
- **Additional PDF file generation support.** Cimmetry® AutoVue® 2D Desktop (now Oracle® AutoVue) enables Adlib Express Server to generate PDF versions of additional file types, in particular MicroStation® (.dgn) and AutoCAD® (.dwg).
• **Microsoft .NET™ 2.0 framework.** An integral Windows component required to run applications developed with .NET technology. The version used for the implementation of UACT is 2.0.

• **Oracle Client.** In order for the IIS web server to communicate with the Oracle database server and retrieve data, it requires a data provider that supports Oracle. The UACT implementation at TTI uses the .NET Managed Provider for Oracle from Microsoft, which is part of the .NET 2.0 framework.

As Figure 1 shows, the UACT implementation uses two server side environments: a database server (that includes Oracle and ArcSDE) and a web server (that includes all other components in addition to the UACT code). The web server also stores all files uploaded to the system as well as data files UACT generates during the utility adjustment process. A UACT implementation at TxDOT will likely involve separate mapping and data storage servers. In addition, TxDOT would connect UACT to an existing email server to allow for system-generated email notifications.

**SPACE REQUIREMENTS**

**Client Side Space Requirements**

On client computers, requirements are minimal. Other than the applications listed previously (i.e., an internet browser, PDF viewer, and an email client), users do not need to install additional components. During the submission of utility agreement applications to TxDOT, users need to have access to files they need to upload to the server. Currently, there is no limit on the number of files or file size a user can upload to UACT. In an implementation of the prototype, TxDOT should consider a suitable limit for both file size and number. For example, the limit on the file size a user can upload could be stored as a parameter in a configuration file to facilitate modifications and fine-tuning of the maximum file size on an as-needed basis. The following sections describe requirements on the server side.

**Server Side Space Requirements**

On the server side, the prototype consists of two servers: a database server, and a web server. The database server uses an implementation of Oracle 10g that consists of several tablespaces. For each tablespace, the researchers created a database schema for the creation of tables, relationships, and indexes. UACT consists of the following tablespaces:

- **UACT.** This tablespace includes the tables of the subject areas Feature, Utility Conflict, Utility Agreement Assembly, Permissions, Project, Document, Meeting, User, and System.

- **DCIS.** This tablespace includes the DCIS Subject Area table.
• **UFD.** This tablespace includes the tables of the UFD (Utility Facility Database) Subject Area.

• **SDE.** This tablespace includes the tables of the ArcSDE Subject Area. Note that the researchers implemented some of the tables of the subtype GAIP (GIS Architecture Infrastructure Project) Feature, including Asset Features and Geopolitical Features as ESRI ArcSDE tables in the SDE Oracle tablespace.

These tablespaces provide the core functionality of the UACT system. During development, the research team created two copies of the UACT tablespace to test changes to the prototype while keeping one version ready for user testing at all times. In addition, the researchers created four additional tablespaces to represent existing/external systems during prototype development. The purpose of the additional tablespaces was to test the ability of the UACT prototype to connect to these systems. During implementation, existing TxDOT systems would replace the following tablespaces:

• **FileNet.** This tablespace includes the tables of the FileNet Subject Area.

• **MainStreet.** This tablespace includes the tables of the MainStreet Texas Subject Area.

• **ROWIS.** This tablespace includes the tables of the ROWIS (Right of Way Information System) Subject Area.

• **UIRPRO.** This tablespace includes the tables of the UIR (Utility Installation Review) Subject Area.

The TTI implementation allocates 100 megabytes for the UACT tablespace. The space actually occupied in the tablespace is currently about 20 megabytes. However, it is possible that a UACT implementation will need additional indexes to increase database query performance, which would require additional space in Oracle.

During prototype development, the TTI implementation allocated 20-30 megabytes each for the tablespaces DCIS, UFD, and SDE. This space requirement was sufficient during database testing. In a production version, these tablespaces may require additional space in Oracle. For more information, please refer to the Oracle configuration section in Chapter 4.

**Secondary Storage Requirements**

In addition to the Oracle database space, UACT requires a secondary storage mainly for files that users upload and PDF conversion of those files. Based on a sample of utility agreement applications submitted during preliminary testing, the approximate file space requirements for secondary storage per utility agreement including file attachments are as follows:

- Minimum: 5 megabytes
- Maximum: 50 megabytes
- Average: 25 megabytes
As a conservative estimate, a utility agreement application could require about 25-50 megabytes of space. For a total of 250 utility agreements per year throughout the state, the total annual secondary storage requirement would be between 6.3 and 12.5 gigabytes of space per year. Although the researchers assume that utility agreements will have the greatest storage requirements, there are additional files that users can upload through UACT. At this point, the researchers estimate an annual secondary storage requirement of no greater than 15 gigabytes.

**MAPPING COMPONENT REQUIREMENTS**

The mapping component has the following two main functions:

- display geographic data of a project and utility features to help locate utility conflicts, and
- allow users to outline utility conflicts using an interactive tool and associate the utility conflict outline with the utility conflict.

The current implementation of the mapping component includes a number of GIS data layers, which the researchers grouped into the following essential and recommended data layers:

- **Essential GIS data layers.** UACT must have the following data layers in order to function properly:
  - Alignments (source: project 0-5475 (1)),
  - Utility Features (source: project 5-2110-01 (2)),
  - Right of way features (source: project 0-5475 (1)), and
  - City Street Layer (source: ESRI) or TxDOT Route Layer (source: TxDOT Technology Services Division (TSD)).

- **Recommended data layers.** These layers are not critical but would be useful to UACT users. This includes mainly TxDOT data layers in the format of ESRI shape file, personal geodatabase, or ArcSDE format such as:
  - TxDOT County Layer (source: TxDOT TSD),
  - TxDOT Control Section 2005 (source: TxDOT TSD),
  - TxDOT District Layer (source: TxDOT TSD),
  - TxDOT Route Marker (source: TxDOT TSD),
  - TxDOT Route Layer (source: TxDOT TSD),
  - City Street Layer (source: ESRI), and
  - Aerial photography (source for current implementation: TxDOT Houston District, stored in MrSid format).

In ESRI shape format, the vector layers (routes, control sections, and so on) require about 500 megabytes of space. UACT uses the county layer in combination with the aerial photography as a convenient tool to help UACT users visually find the location of a utility conflict. However, UACT does not read any data from these layers.
In the case of the Houston aerial photography layer, the spatial resolution is 6 inches. This layer provides aerial photography for a section of IH-10 that covers the extent of the Katy Freeway Project. Users have found that layer very useful because of the quality of information that high-resolution aerial photography can provide. By comparison, one-meter resolution aerial photography—which is available through the Texas Natural Resource Information System (TNRIS)—does not provide adequate resolution to identify features on the ground and is now more than 10 years old. The aerial photography files take up about 210 megabytes of space. For an implementation, it would be advisable to include aerial photography for the entire implementation district, which may require additional storage space. For example, background imagery for Bexar County in San Antonio that the researchers used for a different project at similar resolution ranged between 10 and 25 gigabytes.

It is not critical to have aerial photography as a layer on the UACT mapping component because UACT does not read data from aerial photography. If no aerial photography is available, the implementation should provide a street network layer to help locate utility facilities. Any city street layer TxDOT may already have would be adequate, e.g., the TNRIS StratMap transportation data layer (Phase II), which TNRIS published in December 2006. This dataset is currently available at the county level.

If aerial photography is available, it can be quite useful. In the long term, it is possible the entire state will have high-resolution aerial photography. In the short term, high-resolution aerial photography is only available at certain locations, primarily major urban areas. Conversations with district officials suggest the level of availability of high-resolution aerial photography is increasing, but it is not clear what the current trend is. A preliminary estimate based on the file size associated with the 6-inch aerial photography dataset for Bexar County suggests the entire state could require some 2.2 – 2.4 terabytes of space. In either case, the UACT prototype is prepared to accommodate and display any georeferenced aerial photography data that will become available over the next years.

RETENTION REQUIREMENTS

Currently, TxDOT keeps paper copies of utility agreement assemblies for a certain period of time, at which point the joint-use acknowledgement attachment is detached and moved to a permanent file. The joint-use acknowledgement serves as a means to provide supporting documentation for the (lack of) property interest by utility companies on the land they occupy within the state right of way. Similarly, a joint-use acknowledgement can be used to document the right of TxDOT facilities to occupy a property interest held by a utility company, including fee and easements. The researchers designed the prototype to facilitate and standardize the creation of utility agreement assemblies for reimbursable utility adjustments. However, the prototype does not include a function to sign the agreement digitally, which would be an option for the implementation version. During discussion with TxDOT officials, there was a consensus to start using UACT as a means to facilitate approval of utility agreement assemblies by providing a preview of the documentation to districts and the Right of Way (ROW) Division. As such, TxDOT would lock the assembly for editing by the utility company until a district or the ROW Division has reviewed the assembly. If district and ROW Division approved the assembly, it would be unlocked for printing only and the utility company could print, sign, and
then send the assembly to TxDOT for official approval. If both TxDOT and utility companies agree, a digital signature on the utility agreement assembly could replace the need for printing and sending the signed paper copies to TxDOT. Thus, until the prototype implements digital signatures, retention requirements would not apply to UACT.

The current UACT implementation at TTI does not make a distinction between active utility agreement applications and archived utility agreement applications in terms of database record or associated file locations. The only difference between active and archived agreements is a status value in the database that changes from “active” to “completed” whenever the agreement has completed the entire application process. The system uses the distinction between active and archived utility agreements for the purpose of generating lists, running queries, and generating reports.
CHAPTER 3. COMPLETE SOFTWARE COMPONENT INSTALLATION AND CONFIGURATION

INTRODUCTION

This chapter describes the steps to install and configure all software components UACT needs, assuming a new and complete installation process; i.e., no software components were previously installed on the web server. If some of the software components have been previously installed, it may be necessary to adjust the installation and configuration procedure accordingly. However, the instructions assume the configuration and installation of an Oracle database management system version 10g release 2. In addition, the instructions assume that ESRI ArcSDE version 9.2 has been installed on the database server.

Unless otherwise indicated, this chapter assumes the following sequence for installing and configuring software components:

1. Folder structure creation and data copying.
2. Microsoft Internet Information Services (IIS) installation.
3. Microsoft Office installation.
4. Oracle 9i client installation.
6. Microsoft .NET 2.0 framework installation.
7. Adlib Express Server 3.8.2 installation.
8. ESRI ArcGIS Server v9.2 installation.
9. UACT mapping component configuration.
10. Microsoft IIS final configuration.
11. ESRI ArcSDE configuration.

The software versions listed above are those used for developing and testing UACT. Installation and configuration steps might vary if using newer software versions. TxDOT should review the corresponding instructions even if a software component is already installed on the TxDOT web server, because UACT may require a need for changes in the software component’s configuration settings.
Names Used in UACT

Throughout the application, the system uses specific names to designate elements such as services, which are necessary for proper communication among components. The system uses the following names:

- **Website.** UACT is the web site name as well as the name of the physical folder that stores the UACT source code.

- **ArcGIS Server.** UACT_MapService is the name of the service used by ArcGIS Server, and UACT_MapApp is the name of the application used by ArcGIS Server.

- **Oracle.** UACT is the name of the Oracle tablespace, and UACT_USER is the username of the account that UACT uses to access the Oracle database (see Configuration of the Oracle Database in chapter 4).

FOLDER STRUCTURE AND DATA COPYING

This manual assumes the letter prefix “D:\” represents the drive on the web server that serves as the repository for UACT folders. Make the corresponding changes in the following instructions if the letter prefix for the installation drive is different. The current UACT implementation uses the following folder structure on the web server to store UACT files (Figure 2):

- **Data.** This folder contains the Oracle export files that include database schemas with most database objects such as tables, views, functions, synonyms, and data. UACT will need these files during configuration of the Oracle database (see chapter 4).

- **FILE_UPLOAD.** Adlib Express uses this folder to convert uploaded UACT documents to PDF.

- **Software.** This folder contains several subfolders with installation files for software components that need to be installed separately.

- **UACT.** This is the main folder, which includes many subfolders containing all UACT related code and data (except GIS data). GIS is a subfolder that contains all GIS vector data.

- **Website.** This folder contains a subfolder called UACT_MapApp, which contains the code of the GIS map application used by UACT.
Use the following procedure to copy the UACT source code and current UACT user files to the web server:

1. Copy the UACT folder (contains the UACT system code) from the UACT Digital Versatile Disk (DVD) to the D: drive on the web server.

2. Unzip all the zipped files in the UACT folder, and place the result in folder D:\UACT.

3. Edit file “SystemParam.cs” (located at D:\UACT\App_Code\Library\) as follows:
   - replace
     
     _appUrl = “http://impdev.tamu.edu/UACT”
     
     with TxDOT’s web address of the UACT system:
     
     _appUrl = “http://<TxDOT web address of the UACT system>/UACT/”
     
     o replace
     
     dbConnectionString = “Data Source=ORAGIM;UID=UACT_USER;PWD=456789;”
     
     with TxDOT’s connection string; and
- search for $D:\$ in the file and replace with the actual installation drive letter where the UACT system will be installed if other than $D:\$.

4. Copy the $FILE UPLOAD$ folder from the UACT DVD to the $D:/$ drive on the web server.

5. Create a $Website$ folder on the $D:/$ drive on the web server.

MICROSOFT IIS INSTALLATION AND INITIAL CONFIGURATION

This section summarizes the steps to install Microsoft IIS and to create a web site for UACT. Use the following procedure to install Microsoft IIS:

1. Under $Start > Control Panel > Add/Remove Programs$, click “Add/Remove Windows Components.”

2. Select $Internet Information Services$ and proceed with the installation process.

3. Open the IIS Manager to verify the IIS installation (Figure 3):

4. In the left panel, navigate the folder tree under the machine name to find “Web Sites.” The web server host listed should be “Default Web Site.”

5. Open Internet Explorer and enter “http://<machine name>” (where $<machine name>$ is the server name). The browser should return either an “Under Construction” page or a “Microsoft IIS Help” page.
The next step is to create a new web site for UACT on the web server. If the web server is a dedicated server to host UACT, there is no need to create a new web site for UACT. It is only necessary to rename the default web site as “UACT.” Note: The name of the UACT web site is “UACT.” As discussed later in the chapter, the physical address of the UACT folder on the web server is also “UACT.” For the configuration of this web site, see section IIS Final Configuration toward the end of this chapter.

If the web server is a dedicated server to host UACT, use the following procedure to rename the IIS default web site:

- In IIS Manager, navigate the folder tree under the machine name to find “Web Sites.”

- Right-click “Default Web Site” and rename the web site as “UACT.”

If the web server will host multiple web sites sharing the same Internet Protocol (IP) address, it is necessary to create a virtual directory within IIS to host UACT. Use the following procedure to create this virtual directory:

- In IIS Manager, navigate the folder tree under the machine name to find “Web Sites.”
Right-click “Default Web Site” and select New > Virtual Directory. The Virtual Directory Creation wizard starts. In the Virtual Directory Alias window, type “UACT” and click “Next” (Figure 4).

Figure 4. Virtual Directory Creation Wizard Virtual Directory Alias Window.
In the Web Site Content Directory window, enter the path or browse to the $D:\UACT$ folder (Figure 5) and Click “Next.”

Figure 5. Virtual Directory Creation Wizard Web Site Content Directory Window.
In the Virtual Directory Access Permissions window, select the Read option (Figure 6). Click “Next” to complete the virtual folder creation wizard.

![Virtual Directory Creation Wizard Access Permissions Window](image)

**Figure 6. Virtual Directory Creation Wizard Access Permissions Window.**

**MICROSOFT OFFICE INSTALLATION**

Microsoft Office must be installed on the web server to allow conversion of Microsoft Office documents to PDF using Adlib Express Server 3.8.2. For simplicity, this section does not include instructions for installing Microsoft Office under the assumption that TxDOT has standardized procedures for installing and configuring Office applications. A standard installation of the software is sufficient. At the very least, install Word, Excel, PowerPoint, and Visio.

**ORACLE CLIENT INSTALLATION**

UACT uses open database connectivity (ODBC) to communicate with the Oracle database. This process requires the installation of Oracle Client on the web server (unless Oracle is installed on the same machine as the web server). For more information, refer to the following references:

- Oracle 9i Client Installation Guide (3)
- Oracle Enterprise Manager Configuration Guide (4).
This section assumes the following parameters associated with a hypothetical Oracle database (change parameters according to the actual Oracle database implementation used):

- **Service name:** SNHYP
- **Host name:** HYP-ORACLE
- **Net service name:** SNHYP
- **Protocol type:** Transmission Control Protocol (TCP)
- **Port type:** 1521

It is necessary to install a version of Oracle Client that is compatible with the version of Oracle installed on the server. The UACT implementation at TTI uses an Oracle 10g Release 2 (10.2.0.1.0) database. The version of Oracle Client installed at TTI was 9i, which is compatible with Microsoft .NET framework 2.0 and the Oracle 10g database. Use the following procedure to install Oracle 9i Client on the web server:

- Insert the Oracle 9i client CD and run the installation setup.exe file. When you get to the File Locations screen, create/select an appropriate Oracle Home name and folder path and click “Next” (Figure 7). Hint: Use the default name and path.

![Oracle Universal Installer: File Locations](image)

**Figure 7. Oracle Client File Locations Window.**
• On the Installation Types screen, select *Runtime* and click “Next” (Figure 8).

**Figure 8. Oracle Client Installation Types Window.**
• The Summary screen lists the components to install (Figure 9). Click “Install” to continue. The installation may take a few minutes to complete.

![Oracle Universal Installer: Summary](image)

**Figure 9. Oracle Client Installation Summary Window.**
• After completing the installation of the components, the Configuration Tools screen appears (Figure 10). After the system starts the tool and the “Next” button becomes enabled, click “Next” to set up or enable a net service name using the Oracle Net Configuration Assistant.

![Oracle Client Configuration Tools Window](image)

**Figure 10.** Oracle Client Configuration Tools Window.
• Select *No, I will create net service names myself* to create a new net service name and click “Next” to continue (Figure 11).

![Figure 11. Oracle Net Configuration Assistant Welcome Window.](image1.jpg)

• Select *Oracle 8i or later database or service* and click “Next” (Figure 12).

![Figure 12. Oracle Net Configuration Assistant Database Version Selection Window.](image2.jpg)
• Enter the service name associated with the database (assumed to be “SNHYP”) and click “Next” (Figure 13).

![Figure 13. Oracle Net Configuration Assistant Service Name Window.](image)

• Select TCP as the network communication protocol and click “Next” (Figure 14).

![Figure 14. Oracle Net Configuration Assistant Network Protocol Window.](image)
• Enter the database computer’s host name (this example assumes HYP-ORACLE), select the port number (this example assumes the default 1521), and click “Next” (Figure 15).

Figure 15. Oracle Net Configuration Assistant Host Name and Port Number Window.
• Select *Yes, perform a test* to perform a database connection test (Figure 16) and click “Next.”

![Oracle Net Configuration Assistant: Net Service Name Configuration, Test](image)

You can verify that an Oracle database can be reached, using the information provided, by performing a connection test.

Would you like to test that a connection can be made to the database?
- [ ] No, do not test
- [x] Yes, perform a test

**Figure 16.** Oracle Net Configuration Assistant Connection Test Window.
• Enter the net service name (Figure 17). By default, the Oracle Net Configuration Assistant assumes the net service name is the same as the service name provided earlier (Figure 13). When finished, click “Next” to continue, and then exit the installer.

![Oracle Net Configuration Assistant Net Service Name Window.](image)

**Figure 17. Oracle Net Configuration Assistant Net Service Name Window.**

### CIMMERTY AUTOVUE 2D DESKTOP INSTALLATION

Cimmetry AutoVue 2D Desktop enables PDF creation using Adlib Express for file types without a corresponding native software installation on the server. For example, AutoVue enables Adlib Express to convert MicroStation .dgn files and AutoCAD .dwg files to PDF without an installation of MicroStation or AutoCAD on the server. For more information, refer to the following reference:


Installing Cimmetry AutoVue 2D Desktop v19.2 is straightforward. To install the software on the web server, use the following procedure:

- Navigate to the folder SOFTWARE\Cimmetry_AutoVue\av19.2\win32\ on the UACT DVD. Double-click “avsetup.exe” to start installation. Note: Running this setup file (which for convenience the researchers downloaded from the vendor’s web site to the UACT DVD) will install an evaluation version of the software. For a full implementation of UACT, TSD will need to acquire a license directly from the software vendor.

- Select the default destination folder and follow the installation instructions.
It is necessary to configure the pen settings in AutoVue to make sure that the PDF files that Adlib Express Server generates are readable. During preliminary testing, the researchers found that in general, the best results with the current versions of AutoVue and Adlib Express involve the use of thin line pen settings. Use the following procedure to configure pen settings:

- Load AutoVue and open a Computer Aided Design (CAD) file, e.g., a MicroStation .dgn file or an AutoCAD .dwg file.
- From the File menu select Print. In the Print Properties window, select the Pen Settings tab (Figure 18).

![Figure 18. AutoVue Pen Settings Window.](image-url)
- Under *Current Pen Settings*, select `default.c2t` from the list of current pen settings (Figure 19).

![Print Properties](image)

**Figure 19.** AutoVue Customized Pen Settings Window.

- Under *From/To*, select all entries by clicking on the first entry, then shift-click the last entry. Under *Change/Thickness*, set all line weights to 0.01 inch (0.254 mm) and click “OK.”

**MICROSOFT .NET 2.0 FRAMEWORK INSTALLATION**

The programming interface of UACT uses the Microsoft .NET 2.0 framework. For UACT to function properly on the web server, users must install the .NET 2.0 framework. Note that only users with administrative privileges can install the .NET 2.0 framework. Use the following procedure to install Microsoft .NET 2.0 on the web server:

- Navigate to the folder `SOFTWARE\Microsoft_NET\` on the UACT DVD, run file “dotnetfx.exe,” and follow the installation instructions. Microsoft provides the .NET framework free of charge and hence the installation does not require an additional license.
ADLIB EXPRESS SERVER INSTALLATION

To facilitate the creation of PDF versions of user-uploaded files and system-generated forms, install and configure Adlib Express Server on the web server. Note that only users with an administrator privilege on the server can install and/or change Adlib Express Server options. For more information, refer to the following reference:

- Express User Guide Version 3.8 (6)

Note: To install and/or configure Adlib Express, make sure to connect to the server using the Console mode. If you use a remote desktop connection, make sure to use the mstsc/console command. Use the following procedure to install Adlib Express Server 3.8.2 on the web server:

1. Make sure Microsoft .NET Framework 2.0 is installed on the server prior to installing Adlib Express Server.

2. Navigate to the folder `SOFTWARE\Adlib_Express\` on the UACT DVD, run file “ExpressServer382.exe,” select the default complete setup and destination folder, and follow the installation instructions. Note: Running this setup file (which for convenience the researchers downloaded from the vendor’s web site to the UACT DVD) will install an evaluation version of the software. For a full implementation of UACT, TxDOT will need to acquire a license directly from the software vendor.
Use the following procedure to configure Adlib Express Server:

- Start Express Server as an application by selecting Start > All Programs > Adlib > Express > Express Server (Figure 20).

![Express Server Window](image)

**Figure 20. Express Server Window.**

- If Express Server is already running as an application, click “Stop Monitoring.”
• If Adlib Express Server is already running as a service, stop the Adlib Express Server service and then start Express Server as an application in order to change Adlib Express options. To stop the Adlib Express Server service:

  o On the Windows Taskbar select Start > Run, then type “services.msc” and click “OK”;

  o in the Services console, select Adlib Express Server and click the “Stop” button (Figure 21); and

  o start Express Server as an application by selecting Start > All Programs > Adlib > Express > Express Server.

Figure 21. Services Console Window Showing the Adlib Express Server Service.

• From the Tools menu (Figure 20), select Application Settings.
• Select the following options (Figure 22):
  
  o Enable Adlib FMR
  o Enable Restart after — 250 documents
  o Enable Inactivity Timeout — 600 seconds
  o Enable Job Timeout — 1000 seconds
  o Maximum number of Retries: 3

Figure 22. Application Settings Window.
• Click “Options” (Figure 20) to modify Express Server options (Figure 23).

![Figure 23. Express Server Folder Options Window.](image)

• On the *Folders* tab, change the default folder names as follows (Figure 23):
  
  - Input Folder:   D:\FILE UPLOAD\dpiInput-bin
  - Destination Folder: D:\FILE UPLOAD\dpiOutput-bin
  - Output Folder:   D:\FILE UPLOAD\pdfOutput-bin
  - Error Folder:   D:\FILE UPLOAD\error-bin
  - Work Folder:   C:\Adlib Express\Work (default folder)

**Note:** Adlib Express creates default input, output, error, and work folders. For UACT, it is necessary to select the folders above (created after copying the UACT folder from the UACT DVD—see instructions under “Folder Structure and Code Copying” earlier in this chapter).

• Under *Input File Handling*, select *Move File to Destination Folder*. 
• Check *Enable Logging* and click the “…” button underneath. The Log Settings window appears (Figure 24). In the Log Settings window, select the following settings:

  o *Retention period:* 14 days
  o *Enable Document Log*
  o *Retain Process Log History* (if you would like to debug Adlib Express)
  o *Compress Process Log History to Zip* (if you would like to debug Adlib Express)
  o *Retain Document Log History* (if you would like to debug Adlib Express)

![Log Settings Window](image)

**Figure 24. Log Settings Window.**
On the Processing tab (Figure 25), select the following settings:

- Check Input Folder Every 5 seconds
- Enable DPI/XML Job Ticket Processing
- Move File to Destination Folder option under Job Ticket File Handling
- Cancel DPI Job Ticket Processing on Conversion Error
- Cancel DPI Job Ticket Processing on Missing Document Input
- Cancel DPI Job Ticket on PDF Security

Figure 25. Express Server Processing Settings Window.
On the Outputs tab (Figure 26), click the “…” button under Convert to PDF Format.

Figure 26. Express Server Outputs Settings Window.
The Information Settings screen appears (Figure 27). In this screen, select the following settings, then click “OK”:

- *Move File to Output Folder* under *File Handling*
- *filename.ext.pdf* under *File Naming*
- *Preserve File Extension*
- *Preserve Last Modified Date*

![Convert To PDF Settings Window](image)

Figure 27. Convert to PDF Settings Window.
• Click the “…” button under Convert to PDF Information Format in the Express Server Options window (Figure 26). The Convert to PDF Information Settings screen appears (Figure 28). On this screen, do the following:

  o Select the following options under PDF Information Type:

    - Text
    - File
    - Pages
    - Bookmarks

  o Select the following options under PDF Information Options:

    - Format: CSV
    - Encoding: ISO88591
    - CSV Delimiter: ,
    - CSV Headings: No
    - Text Style: Default

Figure 28. Convert to PDF Information Settings Window.
• On the PDF Options tab (Figure 29), select the following settings:

  o PDF Version: 1.3
  o PDF Type: PDF
  o Font Embedding
  o Enable PDF Security
  o Enable PDF Open Settings

Figure 29. Express Server PDF Options Settings Window.
On the PDF Options tab of the Express Server Options window, click the “…” button under PDF Options (Figure 29). The PDF Compression Options screen appears (Figure 30). Select the following settings and click “OK”:

- **Optimize for Fast Web View**
- **Page Content Compression**
- **Resolution**: 300 dpi
- **Color Image Compression**: Automatic
- **Compression Level**: Maximum
- **Monochrome Image Compression**: CCITT Group 4

![PDF Compression Options Window](image)

**Figure 30. PDF Compression Options Window.**
• On the *PDF Options* tab of the Express Server Options window, click the “…” button under *Bookmarks, Hyperlinks, and Table of Contents Settings* (Figure 29). The Bookmarks, Hyperlinks, and Table of Contents Settings window appears (Figure 31). Select the following settings and click “OK”:

  - Enable Bookmarks
  - Do not select (or unselect) *Enable Hyperlinks*

![Figure 31. Bookmarks, Hyperlinks, and Table of Contents Settings Window.](image)

• On the *PDF Options* tab of the Express Server Options window, click the “…” button under *Font Embedding* (Figure 29). The Font Embedding Options window appears (Figure 32). Select the following settings and click “OK:”

  - Embed Partial Fonts
  - Embed Standard Fonts
  - Embed Licensed Fonts
  - Multi-Language Support

![Figure 32. Font Embedding Options Window.](image)
On the *PDF Options* tab of the Express Server Options window, click the “…” button under *Enable PDF Security* (Figure 29). The PDF Security Settings window appears (Figure 33). Select the following settings and click “OK”:

- *Encryption*: 40 Bit Encryption – Acrobat 3+
- Do not select (or unselect) *Printing*
- *Changing the Document*
- *Selecting Text and Graphics*
- Do not select (or unselect) *Adding or Changing Annotations and Form Fields*

![PDF Security Settings Window](image.png)

Figure 33. PDF Security Settings Window.
On the PDF Options tab of the Express Server Options window, click the “…” button under Transformation (Figure 29). The Transformation window appears (Figure 34). Select the following settings and click “OK”:

- Do not select (or unselect) Enable Page Scaling
- Enable Page Content Scaling
- Scale by Margin (inches): 0.25 (all margins)
- Page Content Alignment: Center-Center

![Transformation Settings Window](image.png)

**Figure 34. Transformation Settings Window.**
On the PDF Options tab of the Express Server Options window, click the “…” button under Enable PDF Open Settings (Figure 29). The PDF Open Settings window appears (Figure 35). Select the following settings and click “OK”:

- Page Mode: Bookmarks and Page
- Magnification: Default
- Page Number: 1
- Page Layout: Single Page
- Only Display Bookmark Panel if Bookmarks Exist

![PDF Open Settings Window](image)

Figure 35. PDF Open Settings Window.

Select the Document Options tab on the Express Server Options window (Figure 36):

![Express Server Document Options Window](image)

Figure 36. Express Server Document Options Window.
Click the “…” button under **Computer Aided Design (CAD) Settings**. The Computer Aided Design (CAD) Settings window appears (Figure 37). Select the following settings and click “OK”:

- **Convert HPGL Using Native Application**
- **Portrait Page Size**: Tabloid
- **Landscape Page Size**: Tabloid
- **Margin (inches)**: 0.25 (both vertical and horizontal)

**Figure 37. Computer Aided Design Settings Window.**
On the Document Options tab in the Express Server Options window, click the “…” button under HTML Settings (Figure 36). The HTML Settings window appears (Figure 38). Select the following settings and click “OK”:

- Orientation: Portrait
- Size: Letter
- Margins (inches): 0.25 (all margins)

Figure 38. HTML Settings Window.
On the **Document Options** tab in the Express Server Options window, click the “…” button under **Text Settings** (Figure 36). The Text Settings window appears (Figure 39). Select the following settings and click “OK”:

- **Font Name**: Courier New
- **Font Style**: Regular
- **Enable Page Layout Settings**
- **Orientation**: Portrait
- **Page size**: Letter
- **Font Size**: 7
- **Margins (inches)**: 0.25 (both vertical and horizontal)

![Text Settings Window](image)

**Figure 39. Text Settings Window.**
When finished with the settings, click “OK” on the Express Server Options window to save the changes and go back to the main interface (Figure 40).

Figure 40. Express Server Main Interface Window.

To run Express Server as an application, click “Start Monitoring.”

- If Express Server will be used as a service and it stops working (making it necessary to restart the service), first run Express Server as an application to clear all pending PDF conversion jobs in the folder E:\UACT\FILE_UPLOAD\dpiInput-bin.

- Under normal operation conditions, it is not advisable to run Express Server as an application in an environment where it may be necessary to convert hundreds of files to PDF. Although Express Server has an option to restart automatically after processing a predetermined number of files (which the vendor recommends), that option tends to fail often when running Express Server as an application.
To create an Adlib Express Server service, perform the following steps:

- Open the Command Prompt console by selecting Start > Run, then type “cmd” and click “OK.” The command prompt window opens.

- Enter the following command line (the Adlib Express Server service will be created, but it is not running yet) (Figure 41):

  ```
  C:"Program Files"\Adlib\Express\adexp.exe /INSTALL_SERVICE
  ```

  ![Install Adlib Service Window](image)

  **Figure 41. Install Adlib Service Window.**
To configure the Adlib Express Server service, perform the following steps:

- On the Windows task bar, select Start > Run, then type “services.msc” and click “OK”; and
- on the Services console (Figure 42), right-click “Adlib Express Server” and select Properties to open the Adlib Express Server Properties window (Figure 43).

![Image of Services console with Adlib Express Server selected]

**Figure 42. Adlib Express Server Service Properties Window.**
Select the *Log On* tab in the properties window and configure the service to run with an administrator account (Figure 43).

![Figure 43. Log On Tab of the Adlib Express Server Properties Window.](image-url)
On the Services console (Figure 42), right-click “Adlib FMR” and select Properties to open the Adlib FMR (Fault Monitoring and Recovery) Properties window (Figure 44).

Figure 44. Adlib FMR Properties Window.
To configure Distributed Component Object Model (DCOM) permissions (whether running Express Server as an application or as a service), do the following:

- On the Windows task bar, select Start > Run, then type “dcomcnfg” and click “OK.” The Component Services window appears (Figure 45).

![Component Services Window](image)

**Figure 45. DCOM Config Folder in the Component Services Window.**

- In the Component Services window, expand the Component Services folder until the DCOM Config folder appears. Expand the DCOM Config folder.

- The following DCOM objects belong to applications that Express Server uses in the PDF conversion process:
  - AdConv.AdConvNS
  - AdlibPDF.PDFBookmark
  - AutoVue.Application
  - Microsoft Word
  - Microsoft Excel
  - Microsoft PowerPoint
  - Microsoft Visio
For each of these DCOM objects, complete the following steps:

- Right-click the object and select *Properties* to open the Properties window (Figure 46).

![Properties Window](image)

**Figure 46.** AdConv.AdConvNS Properties Window.
In the Properties window (Figure 46), select the Security tab.

Under Launch and Activation Permissions in Figure 46, select Customize and click “Edit” to show the Launch Permission window (Figure 47).

![Launch Permission Window](image)

**Figure 47. Launch Permission Window.**

- Make sure the account that is running the Express Server service is included in the list of permissible users.
- Click “OK” to close the Launch Permission window.
Under *Access Permissions* in Figure 46, select *Customize* and click “Edit” to show the Access Permission window (Figure 48).

Figure 48. Access Permission Window.
- Make sure the account that is running the Express Server service is included in the list of permissible users.

- Click “OK” to close the Access Permission window.

- Configure Data Execution Prevention (DEP) to ensure that Windows allows the Express Server and Adlib FMR executables to run, as follows:
  
  o On the windows task bar, select Start > Run, then type “sysdm.cpl” and click “OK” to open the System Properties window (Figure 49).

    ![System Properties Window](image)

    **Figure 49. System Properties Window.**

    o Select the Advanced tab. Under Performance, click “Settings.”
Select the Data Execution Prevention tab and select the Turn on DEP for all programs and services except those I select: option (Figure 50).

Figure 50. Performance Options: Data Execution Prevention Setting Tab.

- Click the “Add” button and navigate to C:\Program Files\Adlib\Express. Select adexp5.exe and click “OK.”

- Repeat the last step to add the “AdlibFMR.exe” file.

- Click “OK” several times until exiting the properties window.
To configure Adlib Express Server to run as a service automatically, use the following procedure:

- On the Windows task bar, select Start > Run, then type “services.msc” and click “OK” to display the Services console (Figure 51).
o On the Services console, right-click “Adlib Express Server” and select Properties (Figure 52).

o On the General tab, select the startup type Automatic and click “OK.”

![Adlib Express Server Properties (Local Computer)](image)

Figure 52. General Tab of the Adlib Express Server Properties Window.

o Close the Services console.

o Close any open applications and reboot the server. Adlib Express Server will start up automatically after rebooting the server.

ESRI ARCGIS SERVER V9.2 INSTALLATION

This programmer guide assumes that ESRI ArcGIS Server version 9.2 has been installed on an implementation server that will be available for the UACT application. This programmer guide will not provide guidance on the installation of ESRI ArcGIS Server. However, in the following section, the programmer guide provides systematic instructions for the configuration of the ArcGIS Server mapping component.
UACT MAPPING COMPONENT CONFIGURATION

This section provides instructions on the configuration of the UACT mapping component that displays GIS data including aerial photography, route network, utility installations, and utility conflict outlines. The mapping component configuration includes the generation of a new GIS Administrator account, creation of a new map service, and creation of a new map application.

Create A New ArcGIS Server Administrator

The installation of ArcGIS Server should instruct the installer to create a new GIS Server Administrator account in the agsadmin system user group. If the account does not exist, create a new account as follows:

- Go to Start > All Programs > Administrative Tools > Computer Management.
- Double-click on “System Tools.”
- Double-click on “Local Users and Groups.”
- Click on “Users.”
- In the Computer Management menu bar, select Action > New User and provide the required information.
Now the user can be added to the groups of GIS server administrators on the map server, as follows:

- Go to **Start > All Programs > Administrative Tools > Computer Management.**
- Double-click on “System Tools.”
- Double-click on “Local Users and Groups.”
- Click on “Groups.”
- Double-click on “agsadmin.”
- Click on “Add,” enter the GIS server administrator account name, and click “OK” (Figure 53).

![Figure 53. GIS Administrators Properties Window.](image-url)
Next, add the GIS server administrator account to the group of server administrators, as follows:

- Go to Start > All Programs > Administrative Tools > Computer Management.
- Double-click on “System Tools.”
- Double-click on “Local Users and Groups.”
- Click on “Groups.”
- Double-click on “Administrators.”
- Click on “Add,” enter the GIS server administrator account name, and click “OK” (Figure 54).

![Administrators Properties Window](image)

**Figure 54. Server Administrators Properties Window.**

You now have sufficient permission to login to ArcGIS Server Manager and create a new Map Service.
Create a New Map Service

To create a new map service, follow these steps:

- Go to Start > All Programs > ArcGIS > ArcGIS Server for the Microsoft .NET Framework > ArcGIS Server Manager.

- A browser window should open a login page similar to the page shown in Figure 55:

![ArcGIS Server Manager Login Page](image)

Figure 55. ArcGIS Server Manager Login Page.
• Log into ArcGIS Server Manager by providing the username and password and clicking on “Log In.”

• Select the Services tab at the top of the page (Figure 56).

• Select a folder on the left-hand side under Folders, or create a new folder by clicking on “Add” under Folders.

• Click on the “Add New Service” link.

Figure 56. ArcGIS Server Manager, Services Tab.
• Enter “UACT_MapService” in the Name box of the Add New Service screen (Figure 57).

• Select Type: *Map Service*.

• Provide a description if desired.

• Select Startup Type: *Automatic*, and click “Next.”

![Figure 57. ArcGIS Server Manager, Add New Service, Step 1.](image)
- Under *Map Document*, browse to the location of the UACT ArcMap document to be used by the map (Figure 58). This should be located at d:\UACT\GIS\ArcMapDocument\.

- Under *Output Directory*, enter the following:
  
  d:\arcgisserver\arcgisoutput

- Under *Server Cache Directory*, enter the following
  
  d:\arcgisserver\arcgisache

- Click “Next.”

---

Figure 58. ArcGIS Server Manager, Add New Service, Step 2.
• On the following screen, use the default settings as shown in Figure 59, and click “Next.”

Figure 59. ArcGIS Server Manager, Add New Service, Step 3.
• On the following screen, use the default settings shown in Figure 60, and click “Save.”

**Figure 60.** ArcGIS Server Manager, Add New Service, Step 4.
• ArcGIS Server Manager should return to the Services tab, as shown in Figure 61.

Figure 61. ArcGIS Server Manager, Add New Service, Step 5.
To start the new service, do the following:

- Check the checkbox next to the new map service and click “Start” (Figure 62).

![ArcGIS Server Manager: Start New UACT Map Service.](image)

- The map service is now started. If you want to edit or modify any settings of the map service, click the pencil icon in the Edit column of the map service’s row.
Create A New Map Application

Now we can proceed to create a map application that uses the new map service, as follows:

- Select the *Applications* tab on the top menu.
- Click on “Create Web Application” link (Figure 63).

![ArcGIS Server Manager, Applications Tab.](image)

**Figure 63.** ArcGIS Server Manager, Applications Tab.
• The Web Application screen should appear (see Figure 64).

• Enter the applicable host name under Host.

• Enter “UACT_MapApp” in the Name box and click “Next.”

**Figure 64.** ArcGIS Server Manager, Create New Web Application: Specify Name and Host.
• Under *Available Services*, expand ArcGIS Server Local node and select *UACT_MapService*.

• Click “Add” to select the map service to the map application (*Figure 65*).

• Click “Next.”

*Figure 65. ArcGIS Server Manager, Create New Web Application: Select Map Service.*
• On the following screen, select *Editing*, and click “Add” (Figure 66).

Figure 66. ArcGIS Server Manager, Create New Web Application: Select Tasks.
Click “Configure,” and under the General tab check the checkbox next to Utility Conflict Outline (Figure 67).

Figure 67. ArcGIS Server Manager, Create New Web Application: Configure General Preferences of Task.
• Under the Settings tab, under Snapping Rules, check Vertex, Edge, and End for the Utility Conflict Outline layer (Figure 68).

Figure 68. ArcGIS Server Manager, Create New Web Application: Configure Settings Preferences of Task.

• Do not change the other default settings.

• Click “OK” to leave the Task Configuration window.

• Click “Next.”
• On the ArcGIS Server Local Connections screen, make sure the user name shown in the textbox belongs to the server administrators and agsadmin group on the map server (see section Create A New ArcGIS Server Administrator at the beginning of this chapter) (Figure 69).

• Click “Next.”

Figure 69. ArcGIS Server Manager, Create New Web Application: Verify Local Connection User Name.
• On the Set Page Properties screen, enter “UACT Map Application” in the Title text box (Figure 70).

• Click “Next.”

Figure 70. ArcGIS Server Manager, Create New Web Application: Set Page Properties.
• Click the “Settings” button next to *Overview Map* and check *Show when web application starts* (Figure 71).

• Click “OK.”

• Click “Finish.”

![ArcGIS Server Manager, Create New Web Application: Overview Map Settings Window.](image)

Figure 71. ArcGIS Server Manager, Create New Web Application: Overview Map Settings Window.

This completes the creation of the GIS map application. UACT will now be able to use this map application to view utility and project data.
MICROSOFT IIS FINAL CONFIGURATION

This section summarizes the steps to configure IIS to enable the UACT web site. Use the following procedure to configure the UACT web site created earlier in the installation process:

- Open IIS Manager: Navigate to Start > Control Panel > Performance and Maintenance > Administrative Tools, and click the “Internet Information Services” shortcut.

- In the left panel of the IIS Manager, right-click on UACT web site (or virtual directory) and select Properties in the context menu. The UACT Properties window appears (Figure 72).

Figure 72. UACT Properties Window.
• Click the “Configuration…” button on the Virtual Directory (or Home Directory) tab (Figure 73).

Figure 73. UACT Properties Window: Virtual Directory Tab.
• The Application Configuration window appears (Figure 74).

• In the Application Configuration window, select the Options tab. Under Application Configuration, set the following:
  
  o **Session timeout**: 60 minutes.
  o Check **Enable buffering**.
  o Check **Enable parent paths**.
  o **ASP script timeout**: 240 seconds.

• Click “OK” to return to the Virtual Directory tab.

![Application Configuration Window: Options Tab.](image)

**Figure 74. Application Configuration Window: Options Tab.**
• Select the **HTTP Headers** tab *(Figure 75).*

• Check the *Enable content expiration* checkbox.

• Under *Web site content should*, select the *Expire immediately* radio button.

![UACT Properties Window: HTTP Headers Tab.](image)

*Figure 75. UACT Properties Window: HTTP Headers Tab.*
• Click the “MIME Types…” button. The MIME Types window appears (Figure 76).

![MIME Types Window]

**Figure 76. MIME Types Window.**

• In the MIME Types window, click the “New” button. A new MIME Type window opens (Figure 77).

• Type “dgn” for Extension and “dgn” for MIME type.

• Click “OK.”

![New MIME Type Window]

**Figure 77. New MIME Type Window.**
• Repeat the previous steps to create a new MIME Type for the “dwg” extension: Click the “New” button, then enter “dwg” for Extension and “dwg” for MIME type. Click “OK.” Both .dgn and .dwg MIME types (file extensions) are now registered and should appear in the MIME Types window (Figure 78).

![MIME Types Window: New MIME Type.](image)

**Figure 78. MIME Types Window: New MIME Type.**

• Click “OK” to complete the creation of the new MIME types.

• Click “OK” again to close the UACT Properties window.
• In the left panel of the IIS Manager, click “Web Service Extensions” (Figure 79).

![Figure 79. IIS Manager Window: Web Service Extensions.](image)

• Make sure that the status of the following two extensions is “Allowed”:
  - ASP.NET v2.0, and
  - Server Side Includes.

• If the status of any of these three extensions is “Prohibited,” click the service name, then click the “Allow” button to change its status to “Allowed.”

• Close the window after completing this step.
- Using Windows Explorer, expand the UACT folder, right-click the “File_Upload” folder, and select Properties to open the Properties window (Figure 80).

**Figure 80. UACT-UserFiles Folder: Properties Window.**
• In the Properties window, select the Security tab (Figure 81).

![Security Tab](image)

Figure 81. UACT-UserFiles Folder: Security Tab.

• Make sure that Users under Group or user names have read and write permissions, and that Administrators have full control permission.

• Click “OK” to apply the settings.

**ESRI ARCSDE CONFIGURATION**

This section of the installation guide provides guidance on the configuration of ArcSDE. This installation guide assumes that ArcSDE and ArcCatalog have been installed previously. The UACT prototype installed ArcSDE on a server called gim-oracle. The installer should make changes according to the name of the local server used for the installation of ArcSDE. This guide will cover the following activities:

• Creating a new database connection.

• Importing the Utility_Conflict_Outline feature class into ArcSDE.
Create a New ArcSDE Database Connection

To create a new database connection, follow these steps:

- Open ArcCatalog and expand the Database Connections node (Figure 82).
- Click on “Add Spatial Database Connection.”

![Figure 82. ArcCatalog, Database Connections Window.](Image URL)
• In the Spatial Database Connection window, enter your server name in the Server box (Figure 83).

• Enter “port:5151” for Service and your database service name in the Database box.

• Enter username and password of the user account used when installing ArcSDE.

• Click “Test Connection.”

• You should see “Connection succeeded” message. If not, check server name, database service name, and user account again.

• If the connection was created successfully, click “OK” in the message box and click “OK” again.

![Figure 83. Spatial Database Connection Window.](image-url)
• The Database Connection window should show the new connection to the spatial database (Figure 84).

![Database Connection Window](image)

**Figure 84.** New Database Connection in Database Connection Window.

**Importing the Utility Conflict Outline Feature Class into ArcSDE**

To import an existing feature class layer into ArcSDE, follow these steps:

- Right-click on “Connection to <your spatial database server>.”

- Select *Import > Feature Class (Single).*
• The Feature Class to Feature Class window opens (Figure 85).

![Feature Class to Feature Class Window](image)

**Figure 85. Feature Class to Feature Class Window.**

• Under *Input Features*, click the “Browse” button and browse to Utility_Conflict_Outline feature class located at

  d:\UACT\GIS\Geodatabase\ConflictGDB.mdb\Utility_Conflict_Outline

• Do not change the default under *Output Location.*
• Enter a name for *Output Feature Class*: “Utility_Conflict_outline” (Figure 86).

![Feature Class to Feature Class Window, Output Feature Class](image)

**Figure 86.** Feature Class to Feature Class Window, Output Feature Class.

• Click “OK.”

• Click “Close” in the following dialog box (Figure 87).

![Feature Class to Feature Class Dialog Box](image)

**Figure 87.** Feature Class to Feature Class Dialog Box.
• In the Database Connection window, double-click on “Connection to <Your spatial database server>.” You should see a list of feature classes on your ArcSDE server, including the “Utility_Conflict_outline” feature class you just uploaded (Figure 88).

![Database Connection Window](image)

Figure 88. New Feature Class in Database Connection Window.

• The feature class Utility_Conflict_Outline will be used by the ArcMap document, which in turn ArcGIS Server map service uses to display outlines of utility conflicts.

• This completes the configuration of ArcSDE.
CHAPTER 4. COPYING DATA AND VERIFICATION OF UACT SETUP

INTRODUCTION

This chapter describes the steps to copy data to the Oracle database. The dataset includes seed data and utility installation request data from the TTI UACT prototype implementation. This chapter provides guidance for the following activities:

- configuration of the Oracle database and
- copying of UACT data to the Oracle database.

CONFIGURATION OF THE ORACLE DATABASE

Use the following procedure to configure the Oracle database, which involves creating an Oracle tablespace and an Oracle user account for UACT.
Create a Tablespace for UACT on the Oracle Server

- On the Oracle Server, click “Administration” menu (Figure 89).

- Under Storage column, click Tablespace then click on “Create” button on the far right.

Figure 89. Oracle Enterprise Manager Screen: Administration Tab.
• The Create Tablespace window appears (Figure 90).

• Enter “UACT” for Name.

• Click on “Add” button to add datafile (Figure 90).

Figure 90. Oracle Create Tablespace Window.
• The Add Datafile window opens (Figure 91).

• Click a “Continue” button.

Figure 91. Oracle Enterprise Manager: Add Datafile to Tablespace.
On the Create Tablespace page, click the “OK” button on the bottom right of the screen (Figure 92).

Figure 92. Oracle Create Tablespace Window with New Tablespace.
• To create user accounts for UACT in Oracle, select Users in the Users and Privileges group (Figure 93).

Figure 93. Oracle Administration Window.
• In the Create User window, click the “Create” button and enter information for the UACT_USER account, as shown in Figure 94.

• Make sure to select UACT as the default tablespace for the UACT_USER account.

• Click the “Roles” menu, then click on “Edit List” button (Figure 94).

Figure 94. Oracle Create User Window.
• From the list of available roles, select Resources and then click “Move” (Figure 95).

• Make sure that Connect is also listed under Selected Roles.

• Click “OK,” then click “OK” again.

Figure 95. Oracle Modify Roles Window.
• Repeat the previous steps to create additional tablespaces and user accounts as shown in Table 1:

<table>
<thead>
<tr>
<th>Tablespace Name</th>
<th>User Account</th>
<th>Minimum Tablespace Size</th>
<th>Datafile Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileNet</td>
<td>FileNet_User</td>
<td>20 MB</td>
<td>FileNet_Data.dbf</td>
</tr>
<tr>
<td>MainStreet</td>
<td>MainStreet_User</td>
<td>20 MB</td>
<td>MainStreet_Data.dbf</td>
</tr>
<tr>
<td>ROWIS</td>
<td>Rowis_User</td>
<td>20 MB</td>
<td>Rowis_Data.dbf</td>
</tr>
<tr>
<td>SDE</td>
<td>Sde</td>
<td>20 MB</td>
<td>SDE_Data.dbf</td>
</tr>
<tr>
<td>UACT</td>
<td>UACT_Owner</td>
<td>100 MB</td>
<td>Uact_Data.dbf</td>
</tr>
<tr>
<td>UFD</td>
<td>UFD_User</td>
<td>30 MB</td>
<td>UFD_Data.dbf</td>
</tr>
<tr>
<td>UIRPRO</td>
<td>UIRPRO_User</td>
<td>200 MB</td>
<td>UIRPRO_Data.dbf</td>
</tr>
<tr>
<td>DCIS</td>
<td>DCIS_User</td>
<td>20 MB</td>
<td>DCIS_Data.dbf</td>
</tr>
</tbody>
</table>

COPYING UACT DATA TO THE ORACLE DATABASE

The installation DVD contains the following Oracle export files:

• **Uactdev_owner_8_5_2008.dmp.** This file contains the UACT schema including most database objects such as tables, views, functions, synonyms, and data. Import this schema from UACTDev_owner to UACT_Owner.

• **Uactdev_user_8_5_2008.dmp.** This file contains synonyms of database objects in the schema listed above. The synonyms allow the web application to use resources in other schemas. Import this schema from UACTDev_user to UACT_USER.

• **FileNet_user_8_31_2008.dmp.** This file contains the FileNet_User schema.

• **MainStreet_8_5_2008.dmp.** This file contains the MAINSTREET schema including core tables of the MainStreet Texas implementation.

• **Rowis_user_8_31_2008.dmp.** This file contains the Rowis_User schema.

• **Sde_8_31_2008.dmp.** This file contains the SDE schema.

• **UFD_user_8_5_2008.dmp.** This file contains the UFD schema including the database objects and data of spatial utility features.
• **uir20071227.zip.** This file contains the UIRPRO schema. Unzip it before importing the schema.

• **DCIS_8_5_2008.dmp.** This file contains the DCIS schema including the DCIS DATA WAREHOUSE table and sample DCIS data.

After creating all tablespaces and user accounts listed above, import data from the dump files to the Oracle database. It is advisable to copy the whole content of UACT DVD to a local hard drive of the Oracle database server before proceeding.

• Open a command prompt by going to **Start > Run >** and typing “cmd.”

• Navigate to the folder **D:\Data.**

• Import file **Uactdev_owner_8_5_2008.dmp** using the following option (**Figure 96**):

   ```
   FromUser=UactDev_Owner ToUser=Uact_Owner
   ```

   ![Figure 96. Command for Importing Dump File Uactdev_Owner.](image)

• Import file **uactdev_user_8_5_2008.dmp** using the following option (**Figure 97**):

   ```
   FromUser=UactDev_User ToUser=Uact_User
   ```

   ![Figure 97. Command for Importing Dump File Uactdev_User.](image)
• Import FileNet_user_8_31_2008.dmp files without options (Figure 98).

![Command Prompt](image)

**Figure 98. Command for Importing Dump File FileNet_User.**

• Repeat the above steps to import data for all other schemas without options.
CHAPTER 5. UACT INSTALLATION TESTING AND PERFORMANCE

UACT INSTALLATION TESTING

Use the following brief procedure to verify that UACT is working properly (refer to the UACT User Manual for more help on each step):

- Open a new Internet Explorer window, preferably on a different machine than the web server where UACT resides. Type in the URL address for UACT.

- Login to UACT using one of the existing dummy accounts to login (username and password provided separately).

- Create a new project by importing dummy DCIS data.

- Click on the new project in the home screen to log into the new project.

- Import a few utility facilities using dummy UFD data.

- Create a new utility conflict. Creating utility conflicts requires several steps that the user manual describes in detail. Refer to the user manual for more information on how to create utility conflicts (7).

- After the utility conflict is complete, edit the utility conflict outline using the mapping component.

- Create a new utility agreement assembly for the utility conflict created previously. Creating utility agreement assemblies requires several steps that the user manual describes in detail. Refer to the user manual for more information on how to create utility agreement assemblies (7).

- Create additional utility conflicts, and change the status of each conflict under the edit utility conflict option.

- Go to the reports page to verify that the report “create utility conflict certification” is working.

The previous steps presented a brief and quick procedure to verify that the UACT installation is successful. Before UACT becomes fully operational, the researchers recommend testing the prototype during an implementation project with one or more testing districts.
REFERENCES


